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Launching MyCalls 

Select the MyCalls shortcut 
from the Windows desktop.

Or select MyCalls from the Windows menu.
You can locate and launch MyCalls from the 
Program menu in Windows under :
NEC Infrontia\MyCalls\MyCalls.

Select User
Type in the first few letters of the user’s name. The box will be automatically filled
with all the names beginning with those letters. Click ‘Select’ to choose the user or
‘Clear’ to choose no user.

Cancel

Type part of a user name here   Selected user  

Select User

OK

Clear          

Select         

Alice Kettle

Alan Parfitt
Adrian Cross
Alice KettleAlice Kettle

Enter a user name and password
When you are logged in you will be allowed to use the system to the
level that your user has been granted. This could be as either
a user, supervisor or admin.

Cancel

Password

User Name

User Login

OK

Browse           

A

Enter your Username and Password in the 
log on screen. This will launch the default 
screen layout for MyCalls.

If you are unsure of the Username click the 
browse button and use the ‘Select User’  
Dialogue to find a user based on their first 
Initials. Typing more letters will narrow down 
the number of possible users. 

Once the required user is found select the 
name from the list and click the ‘Select’ button.

Welcome to MyCalls

Logging onto MyCalls

This guide is designed to give you a brief 
overview of some of the key features MyCalls, 
although for a comprehensive guide to the 
unparalleled range of call management & call 
performance tools in the MyCalls suite you should 
refer to the full User Manual supplied on CD with 
your NEC system.

MyCalls’ simple “management by exception” 
approach highlights potential problems fast, for 
example, missed calls that could be costing you a 
fortune in lost business.

MyCalls Basic is designed simply to give you a 
flavour of what call management can offer, in 
particular, an ongoing view of call activity.
  
MyCalls Call Manager is fully featured to 
generate real time data for call performance. 
While MyCalls Call Centre takes real time call 
management to the ultimate level.

MyCalls Call Recorder is available for Call 
Manager and Call Centre for call recording, 
playback & archive, valuable for training and 
resolving disputes.
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Default Layout Windows
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Trunk Group - All Trunks

Caller:
Trunk: 

Longest Call Waiting
CIQ: 3

00:01:10

Usage: 10% 

Real Time Parameter Window X

Real Time Parameter Window XReal Time Parameter Window X

Abandoned Calls
All Trunks - Head Office          

Daily

0
Incoming Calls

All Trunks - Head Office          

Daily

55

Outgoing Calls
All Trunks - Head Office          

Daily

20
Extension Status Window X
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Calls

Main Menu

Status Bar
Calls/Unreturned Calls

Real Time Status
(Aspire/SV8100)

Single Value
Incoming Calls

Calls in Queue
(Aspire/SV8100)

Single Value 
Abandoned Calls

Single Value
Outgoing Calls

Call Volume Chart

The default screen for MyCalls gives you a real 
time view of activity on your telephone sys-
tem as it happens. The screen layout can be 
customised to show the information you want 
to see:
1: The cumulative daily total of Incoming Calls 
on all trunks (lines) - Single Value Incoming 
Calls
2: The cumulative daily total of Outgoing Calls 
on all trunks - Single Value Outgoing Calls 
3: The cumulative daily total of Abandoned 
Calls on all trunks - Single Value Abandoned 
Calls. These are calls where the caller hangs up 
before the call is answered. 

4: Trunk Group Status which shows the overall 
utilisation of trunks in real time together with the 
number of calls waiting to be answered and the 
longest current waiting time for the unanswered 
calls. 
5: Extension Status shows which extensions 
are free or busy handling calls. Each extension 
block can be extended to give more detailed 
information about its current activity.
6: The Call Volume Chart shows a cumulative 
record of call activity on all trunks – Incoming, 
Outgoing and Abandoned over the course of a 
24 hour period. 
All the boxes in the information display can be 
moved in the window by clicking & dragging or 
resized by dragging the corners or edges.
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07/02/2009 12:00

07/02/2009 12:01
07/02/2009 12:02

07/02/2009 12:02
07/02/2009 12:06

Options... Refresh

Date/Time Number Extension LocationDuration Type

Period Today Start  01/02/2009 00:00  01/02/2009 00:00End

Number DID Extension Call Types

Inc Out Abd

Max Calls

07074321321 Mobile Network Out301 00:03:01
357 00:03:57

00:01:11
00:13:06

00:39:04

Northwich Inc

Inc Abd
Inc

Inc

360
412

612

Fernley
Wellbrough

Sturnley Mkt

01606327721

10292121321
0707223321

09091112341

View all your calls 

 

 

Calls

Viewing Calls:
A table showing details of individual calls for an 
individual user, or across a group of users or 
across all trunks (the level of access is defi ned 
by the administrator/supervisors), can be 
accessed by moving the cursor over the calls 
tab in the lower left corner of the main window. 

The information in the table can be customised 
by dragging existing columns out of the display 
or choosing additional headers and dragging 
these in from the Column Chooser menu 

Similarly, the buttons at the top of the table 
enable further personalisation of the view.

Where a call recorder is used, the table shows 
calls that have been recorded. For more 
information about recording and playing back 
calls see pages 6 and 7.

Quick Search:
The quicksearch feature allows easy searching 
and playback of calls. You can specify:

1. Search period - Today, Yesterday, This Week, 
Last Week or Custom (specify start and end 
date/Time in the appropriate boxes).
2. Number Called or Dialled
3. DID
4. Extension
5. Call Type - Incoming, Outgoing or Abandoned
6. Specify the maximum number of calls listed

Options: 
1. View your own calls only
2. View All calls in your organisational group 
(supervisor role only)
3. View Calls using Quick Search

Column Chooser:
Provides a selection of call data and statistics 
which can be displayed in the grid. Select the 
Column Chooser List and drag an item across to 
the grid in order to view.
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07/02/2009 12:00
07/02/2009 12:01
07/02/2009 12:02

07/02/2009 12:02

07/02/2009 12:06

Options... Refresh

Date/Time Number Extension Ring Time Location Type

Number DID Extension Call Types

Include calls answered by voicemail

07074321321 mobile network Inc Abd301 01:30

357 03:01

02:11
00:51
05:07

Northwich Inc Abd

Inc Abd
Inc Abd
Inc Abd

360
412
612

Fernley
Wellbrough
Sturnley Mkt

01606327721

10292121321
0707223321

09091112341

 

 

Real Time Parameter Window X

Abandoned Calls
All Trunks - Head Office          

Daily
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Abandoned calls are automatically logged in the Unreturned 
Calls list. Once calls have been returned they are automati-
cally deleted from the list.
 
To view your unreturned calls select the tab from the status 
bar of the screen (bottom left corner)

or select View->Unreturned Calls Window from the main 
MyCalls menu.

Unreturned Calls

Calls Unreturned Calls

View Unreturned Calls

Screen Layout and Pages

The screen layout can comprise of a series of pages. Each page 
can be arranged to display different types of statistics and 
information that you want to view on a regular basis. Save each 
new page separately with a unique name.  
To create a new page select Pages from the Layout menu and 
then choose the New option. Enter a name for your new page e.g. 
‘Main Office Plasma’ and click OK. 
MyCalls automatically saves your page layouts when you exit & 
they are automatically loaded when you restart. 

You can populate your page with the 
information you want to view, for example, 
Extension Grids; Single Value windows, 
etc. Re-size & move the elements you 
add to your page by clicking & dragging 
on the edges and sides of the windows.

Outgoing IncomingAbandoned
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Real Time Parameter Window X
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0

Real Time Parameter Window X

Outgoing Calls
All Trunks - Head Office          

Daily

20If you have saved more than one page and want 
to view a specific page simply select the required 
page from the Quick Page drop-down menu 
found on the main menu bar.

Default

Main Office Plasma

Real Time Parameter Window X

Incoming Calls
All Trunks - Head Office          

Daily

55
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Playback Recorded Calls 

Simple to use interface makes call playback easy for anyone

Playback

A B

X

Select a segment of the recording for playback using A and B buttons:
Rewind, Play, Pause Stop and Fast Forward buttons

The Looping button allows continuous looping of the whole call or looped playback
of call segments.

Save to disk feature allows saving recording as a sound file:

Play call until startpoint of segment is heard - click  
Continue playing until endpoint then click  
Click Play 

Click the save button
Specify your filename
Click OK

If no Users are created in MyCalls you will be able to playback 
all calls. However, once Users are created and Call Playback 
enabled for each you will only be able to playback your own calls 
or (if you are a supervisor) all calls for your group.

You can playback calls straight from the Call Records Grid.

Calls that have been recorded appear in the Call Records View, 
accessed either through the View menu under Call Records 
View or by selecting Calls from the toolbar at the foot of the 
MyCalls screen. Recorded calls are identified by the speaker 
playback icon against the relevant call record. Where a Speaker 
Icon appears you will be able playback that call. 

07/02/2009 12:00
07/02/2009 12:01
07/02/2009 12:02

07/02/2009 12:02

07/02/2009 12:06

Date/Time Number

07074321321

01606327721

10292121321
0707223321

09091112341

Double click the playback 
icon from the calls view to 
open the call player

Playing Back Calls

A
B
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How the Users and Groups affect Call Playback

Organisation

Sales Group

Parts Sales Group

Product Sales Group

Sales Director

Sales Manager

Parts Sales Supervisor Parts Sales Users

Product Sales Supervisor Product Sales Users

The organisation group is the default group which encompasses the 
whole of the organisational tree. Any user at the organisation level can 
listen to calls for any user within the organisation. 

In this example the sales group contains a sales manager (who is 
assigned supervisor privileges) and two sales sub groups, parts sales 
and product sales.

The sales manager can listen to his own calls and any 
calls from the other sales groups.

The sales supervisors can listen to their own calls and any calls from 
their own  group (in this case the Parts Sales Group).  Ordinary Users 
can only listen to their own calls

In order to listen to any calls the supervisors or users must be enabled 
for call playback by the system administrator. Configuration of the call 
playback is decribed in the End User Manual.

In this example the Sales Director has those privileges 
and so can listen to any calls from the various sales 
groups. 
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MyCalls maintains a cumulative log of 
calls made to and from each extension 
on your telephone system.
 
As you can see from the example here, 
Sarah has answered 30 calls during the 
day whereas John has only taken 10.

This information can help pinpoint areas 
where call-handling loads may need to 
be rebalanced to improve inbound 
service, particularly where the system 
also identifies higher levels of 
abandoned calls 

Ext-102-John Ext-103-Mike

Ext-101-Sarah

Ans=30

Ans=15Ans=10

*Ans - calls answered by each extension

101
102
103

Column Chooser...

Extension Name Ans Abd Out
Sarah
John
Mike

30
10
15

0
0
0

0
0
0

Real Time Statistics Grid

The real time statistics grid can show a variety of statistics for each extension. 
Statistics can be chosen from a list using the column chooser. Statistics include 
numbers of calls handled, calls abandoned, and performance indicators such as 
average and maximum wait times.  

View Individual Extensions

See pages 10 &11 for configuration information on real time statistics. 
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The Real Time Statistics option on the 
MyCalls menu          provides a range of 
predefined Group summary views for 
the various devices 
e.g. Extensions or by User Group. 

Configure the information you require 
and your display will show real time 
information about the groups you have 
specified highlighting performance 
issues or service anomalies. 

In this example, the Call Statistics Grid 
summarises the cumulative activity for 
the sales group & the purchasing group. 
The information displayed in the grid 
can be varied by adding additional 
columns from the Column Chooser 
menu and/or by dragging existing 
columns from the grid.

*Ans - calls answered by each extension group

Where the statistics can be viewed by all users in the group(s), say on a plasma 
screen, this can motivate & enhance team performance. Combining Group 
statistics and Individual statistics enables team members to see how well their 
group is performing as well as allowing them to check on thier own performance.

Sales
Purchasing

Group Ans Abd Out
55

100
0
0

0
0

Daily Column Chooser...

Ext-102-John Ext-103-Mike

Ext-101-Sarah

Ans=30

Ans=15Ans=10

Sales Group

Total answered
calls for Sales = 55

Ext-202-Donna Ext-203-Steve

Ext-201-Harry

Ans=30

Ans=20Ans=50

Purchasing Group

Total answered
calls for Purchasing
 = 100

Use Statistics as a motivational tool.

Grouping Extensions

View Group Statistics

See pages 10 & 11 for configuration information on real time statistics. 
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Create Real Time Statistics grids through the 
View menu:  View->Real Time Information->
Real Time Statistics or select the icon for Real 
Time Information              from the main 
toolbar.

Select  Real Time Statistics->Extensions 
->Extension Statistics then Create a New 
Statistics View.

To configure the Grid simply select the 
extensions you want to see.  If these are not 
listed they may need to be enabled for Real 
Time Statistics by following the steps in The 
MyCalls User Manual relating to configuring 
extensions and other devices.

Historical Statistics: are either Daily which 
are totalled or averaged over the whole day 
or Hourly which are totalled or averaged 
each hour (reset on the hour)

Current Statistics show the Last hour’s 
statistics which are totalled or averaged over 
the previous rolling 60 minutes

Once the window is created you can add 
additional columns of information using the 
Column Chooser 

Configure extensions

Mike
Harry

Sarah

John
Steve

Donna

Select the extensions to view
The statistics are filtered to show values for only the ones you have selected

Daily

Historical Current Only

Interval Period

Refresh Time (s)

Edit Title Font...

Edit Statistics Font...               

60

Cancel

Head Office

Real Time Extension Statistics Configuration

OK

PBX

Extensions

Display Values

Extension Statistics Configuration
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Configure extension groups

All System Phones

All User PBX Phones

All Voicemail Ports

Sales Extensions

Purchasing Extensions

Unassigned Extensions

All User Phones

Select the group to view
The statistics are filtered to show values for the type you have selected.
The DID and Pilot Number Statistics may not be available on your telephone
system. Check with your maintainer for details.

Daily

Historical Current Only

Interval Period

Refresh Time (s)

Edit Title Font...

Edit Statistics Font...               

60

Cancel

Head Office

Real Time Group Statistics Configuration

OK

PBX

Extensions

Display Values

Extension-Group Statistics Configuration

Select Real Time Information from the 
View Menu or use             on the main 
toolbar. Click         against Real Time 
Statistics to expand the view, and then 
repeat this for Extension Groups.
 
Select Group Statistics and then select 
Create a New Group Statistics View. 
This launches the screen shown above.

Select an extension group or groups 
from the list of available group views, 
for example Sales Extensions & 
Purchasing Extensions.

Display Values enables you to show 
Historical information either Daily or 
Hourly from the Interval Period menu 
below or Current information which 
shows the previous rolling 60 minutes.

The default Refresh Time is every 60 
seconds but this can be increased or 
reduced according to requirements. 

NOTE: Reducing the Refresh Time 
below 60 seconds may slow response 
in systems with limited computer 
processing capacity.
  
On completion, Click OK and the 
Extensions Group Statistics Grid will 
appear on the Currently Selected 
Layouts page.

+
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Ext-102-John Ext-103-Mike

Ext-101-Sarah

Ans=30
Abd Wait=30

Abd Wait=10 Abd Wait=20

Ans=15Ans=10

Sales Group

Total answered
calls for Sales = 55

Average Abandoned
wait time for Sales
is (30+20+10)/3 = 20 
seconds

Real Time Parameter Window X

Incoming Calls
Sales Extensions - Head Office          

Daily

55
Real Time Parameter Window X

Avg Abd Wait Time
Sales Extensions - Head Office          

Daily

20

View Single Value Group Statistics

Call Rate and Call Perfomance Statistics

Nothing focuses the mind like a picture.
 
That’s why MyCalls is able to highlight a range of 
call statistics as single value windows, providing 
easy to read data with each call type having a 
specifi c colour code for ease of identifi cation.
 
Single value statistics are ideal for plasma screen 
displays, on which key performance indicators can 
be given added emphasis.

The following information is presented in this way:

Call Rate: cumulative counts for incoming,
outgoing and abandoned calls over historical or 
current periods.

Call Performance: cumulative totals, average 
values, or number of calls exceeding allowed limits 
can be individually confi gured.

In the example above the Cumulative Incom-
ing Calls answered by the Sales Group is 55 
and the Average Abandoned Wait Time is 21 
seconds.

*Ans - calls answered by each extension group

Call Rate refers to the number of calls in a 
given period e.g. per hour or per day. Call 
Performance relates to the speed at which calls 
are answered, how long calls are taking and 
how many callers abandon because they have 
waited too long for a reply. 

Single value windows can be confi gured to 
show one of a range of Call Rate and 
Performance statistics. 

Multiple Single Value windows can be displayed 
and arranged on screen in order to make up a 
plasma display.
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Call Volume Chart X

Show Title
Show Interval

Incoming Overflow

Show PBX

Select the group to view

Sales Extensions

Historical Current Only

Show Single Value

Group

Display Values

Interval Period

Refresh Time (s)
60

Head Office

Daily

Real Time Graph Configuration

CancelOK

Display Font...

PBX

Visibility
Show Group
Show Value

Title

Incoming Calls

The statistics are filtered to show values for the type you have selected.
The DID and Pilot Number Statistics may not be available on your telephone
system. Check with your maintainer for details.

Included Incoming Call Types

Call Performance statistics can also be presented 
graphically. 

The chart, illustrated, shows a trend of “average 
time to abandon” for calls over the course of a 24 
hour period. The calls relate to the Sales 
Extensions group.

More general values can be configured for trunk 
groups including ‘All Trunks’ which would give an 
overall statistic for the whole business.

Move the cursor over any column in the chart & left 
click the mouse to reveal a red line which can be 
dragged left or right to zoom in on that time 
period view. 

The Chart can be reset by clicking on the 
“clockface” that appears at the left of the Time axis.

The Configuration of a single value statistic is 
similar to that of multiple value statistics shown 
previously. 

Simply select the type of statistic:

24 Hour - Offers an hourly breakdown of 
values over the day from midnight to 
midnight.

Daily - Shows a single value for the whole 
day.

Select the required group for which you are 
displaying the statistic The Show Single Value 
checkbox is available only when configuring 
performance values and determines if a 
numerical window or a graphical window is 
displayed. Check the box in order to display a 
numerical window and select the required 
visibility options.

Select View->Real-Time-Information from the menu
or click the        Icon.
Select Single Value and select the required 
group/statistic e.g.

Real Time Graphical Statistics 

Configure Single Value Windows



14

The Detailed View: is designed for 
Supervisors to rapidly assimilate call 
handling activity. 
It shows a combination of states for the 
call / extension, e.g., Idle; Ringing; 
Incoming etc. In addition, different users 
are shown against their extension, with 
the time spent in that state. 
(E.g., Sarah’s extension 101 has been 
idle for 38 seconds)

Column Chooser...

101
Extn:Sarah
00:00:38

102
Extn:John
00:01:27

103
Extn:Mike
00:00:07

104
Extn:Steve
00:03:07

Idle (2) Off Hook (0) Ringing (1) Incoming(1) Hold(0) Outgoing(0)

Extension Status Window

Status Views

Column Chooser...

Sarah

John

Mike

Steve

101

102

103

104

Idle

Idle

Ringing

Incoming

00:00:38

00:01:27

00:00:07

00:03:07

Name Number Status Time

Extension Status WindowSummary View: Only the currently 
active state is shown, e.g., the status of 
Sarah’s extension. However more 
detailed information can also be shown. 
This additional information can be 
viewed by dragging items from the 
Column Chooser menu in the window.

Overview: This view shows the state 
of many extensions on one screen. As 
the current state changes for each 
extension, so the colour of its 
indicator bar changes as a visual 
prompt to its particular state, e.g.,  
yellow = ringing (this is the default 
colour, although all system display 
colours can be customised - see the 
detailed MyCalls Manual supplied on 
disc with your system) .

The indicator bar can be expanded 
and collapsed by clicking on the 
arrows on the right. The expanded 
mode shows similar information to the 
Detailed View above.   

Extension Status Window X

101

>>

102

>> 308

>>

103

>> 309

>>

104 >> 310

>>

302

>> 311

>>

304

>> 312

313

318

319

320

321

322Name: Steve
Number: 01660115115
DID: 814992
Time: 00:02:14
Status: Incoming

307

Name: Steve
Number: 01660115
DID: 814992
Time: 00:02:14
Status: Incoming

>
> >

320

3

>> 32

32

>
>>

To access the real time status window configuration:
Select View->Real Time Information->Real Time 
Status from the main menu and select the group or 
device you wish to configure e.g. Extensions, DIDs, 
Trunk Groups etc. 

Real Time Status windows offer three ways of viewing extension or user status: 
    Detailed      Summary      Overview.
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Running Preconfigured Reports

A typical Call Details report.

MyCalls provides a wide range of preconfi gured 
reports that enable you to examine and analyse 
all aspects of telephone use and call 
performance. These can be further customised 
to suit individual requirements. 

The reports and the custom options available 
vary according to your NEC system and the 
version of MyCalls software you are running.

Reports can be edited to fi lter the information 
shown. For example, the Daily Reports List: All 
Calls generates a list similar to that produced 
by a call logger. However, with MyCalls (Call 
Manager & above) it is then possible to fi lter the 
data to pinpoint calls routed to or from specifi c 
extensions or extension groups.

Summary Reports can provide broader long term 
statistics than those available in the real time 
screens, for example, monthly summaries of 
calls broken down by DID, etc. 

Full details of running, confi guring and 
customising reports can be found in Section 14 
of the MyCalls User Manual on the DVD supplied 
with your NEC system.  

To run/view one of the reports:
Select Reports from the main menu or click the Reports icon on the toolbar. • 
Then choose Report Items from the options available.• 
You can then choose from Custom; Daily; Monthly or Weekly Reports.• 

Example: Select Weekly Reports/List: Call Details
On the Confi gure Reports Screen select Task: Run Report Item
MyCalls then compiles a detailed list of calls made over the previous 7 days
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MyCalls contains an unparalleled range of call management & call performance tools that will help every 
business improve its customer service and improve accuracy of response to calls

MyCalls Basic configured to give you a flavour of what call management can offer. 
Using a “management by exception” approach, MyCalls quickly draws your attention to issues that are 
business critical, such as missed calls, which could be costing you money. 

MyCalls Call Manager fully featured to generate real time data about every aspect of call performance.
It is easily configurable to provide you with the particular information or service support you need, 
performance statistics and reports, users and extension activity, costs, DDI management and much more. 

MyCalls Call Centre takes real time call management to the ultimate level offering all the functionality of 
Call Manager but with the added benefits of Automatic Call Distribution, essential to agent productivity
and automatic call queue management. Like Call Manager, it is fully configurable to satisfy individual 
requirements. 

MyCalls Call Recorder is available for Call Manager & Call Centre, enabling calls to be recorded, played 
back and archived. This is particularly valuable for training and for dispute investigation and resolution. 
 
MyCalls Desktop controls your phone direct from your desktop, sophisticated call activity at the click of a 
button combined with advanced screenpop capability to quickly find your business contacts prior to 
answering a call.

MyCalls Enterprise  offers multi-site call management. Manage all your offices from a central location.

Save all layout pages: Simply click to save your MyCalls custom screen layouts. Recover 
saved pages fast using the Quick Page drop down menu at the right. (MyCalls 
automatically saves the last layout displayed on closing) 

Configure Reports: Quick access to menus that let you select, configure and run reports. 
Reports can be saved for later use or added to a schedule for automatic generation
whenever required. 

Reload current page layout: click to display the current layout

Create Real Time Window: Use this to customise your screen layouts with different real 
time data.

The MyCalls Product Range

MyCalls Application Icons


